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WARNING
To prevent fire or shock hazard, do not
expose the unit to rain or moisture.

Owner’s Record

The model and serial numbers are located on the
back of the unit. Record the serial number in the
space provided below. Refer to them whenever
you call upon your Sony dealer regarding this
product.

Model No. PCWA-C500
Serial No.______________

CAUTION

Any changes or modifications not expressly
approved in this manual could void your warranty.

FCC ID: AK8PCWAC500

Exposure to Radio Frequency Radiation.

The radiated output power of the Wireless LAN
PC Card is far below the FCC radio frequency
exposure limits.

Nevertheless, the Wireless LAN PC Card shall be
used in such a manner that the potential for human
contact during normal operation is minimized.

NOTE:

This equipment has been tested and found to
comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules.
These limits are designed to provide reasonable
protection against harmful interference in a
residential installation. This equipment generates,
uses, and can radiate radio frequency energy and,
if not installed and used in accordance with the
instructions, may cause harmful interference to
radio or communications. However, there is no
guarantee that interference will not occur in a
particular installation. If this equipment does
cause harmful interference to television reception,
which can be determined by turning the equipment
off and on, the user is encouraged to try to correct
the interference by one or more of the following
measures:
– Reorient or relocate the receiving antenna.
– Increase the separation between the equipment

and receiver.
– Connect the equipment into an outlet on a

circuit different from that to which the receiver
is connected.

– Consult the dealer or an experienced radio/TV
technician for help.

This device compiles with Part 15 of the FCC
Rules.  Operation is subject to the following two
conditions: (1) This device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

You are cautioned that any changes or
modifications not expressly approved in this
manual could void your authority to operate this
equipment.

Safety Information
WARNING
• Opening the unit, for whatever reason, could

lead to damages that are not covered by the
warranty.

• Do not use this equipment on hospital premises.
Doing so may cause medical devices to
malfunction.

• If using the equipment near a pacemaker, make
sure it is at least 9 inches (22 cm) away from
the pacemaker.

• Do not use this equipment in an aircraft, as
doing so could cause the aircraft's equipment to
malfunction. Make sure you remove the
equipment from the PC card slot before
carrying your computer onto an aircraft.

• Do not use this equipment outdoors.
• The use of optical instruments with this product

will increase eye hazard.
• Install and connect this product by following

descriptions in its Operating Instructions and
Quick Start Guide before using it.

• This equipment generates and radiates radio-
frequency energy. In order to comply with FCC
radio-frequency radiation exposure guidelines
for an uncontrolled environment, this
equipment has to be installed and operated
while maintaining a minimum body to antenna
distance of 20 cm. Based on continuous
exposure of 30 minutes.
Users are not permitted to make changes or
modify the system in any way.

• Indoor use only.
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About the supplied software

THE SUPPLIED SOFTWARE IS SUPPLIED
PURSUANT TO THE APPLICABLE END-
USER LICENSE AGREEMENT.
• Copyright laws prohibit reproducing the

software or the software manual in whole or in
part, or renting the software without the
permission of the copyright holder.

• In no event will SONY be liable for any
financial damage or loss of profits, including
claims made by third parties, arising out of the
use of the software supplied with this product.

• In the event a problem occurs with this software
as a result of defective manufacturing, SONY
will replace it at SONY’s option or issue a
refund; however, SONY bears no other
responsibility.

• The software provided with this product cannot
be used with equipment other than that which is
designated for use with.

• Please note that, due to continued efforts to
improve quality, the software specifications
may be changed without notice.

Program © 2001, 2002 Sony Corporation,
© 2000-2001 Atheros Communications, Inc., All
Rights Reserved

Documentation © 2002 Sony Corporation

Sony, VAIO, and the VAIO logo are trademarks
of Sony Corporation.

Microsoft, Windows, and Windows Me are
registered trademarks of Microsoft Corporation in
the United States of America and other countries.

MMX and Pentium are registered trademarks of
Intel Corporation.

All other trademarks are trademarks of their
respective owners.

Notes:
• The user interface of the Sony supplied

software may differ slightly from that shown in
this manual.

• This manual is written based on the assumption
that you are familiar with basic operations of
the Windows operating system. For computer
operations, refer to manuals that come with
your computer.

• In this manual, Microsoft® Windows® Me is
referred to as Windows Me.

• In this manual, Microsoft® Windows® 2000
Professional is referred to as Windows 2000.

• In this manual, Microsoft® Windows® XP
Professional and Microsoft® Windows® XP
Home Edition are referred to as Windows XP.
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Overview

What you can do with your Wireless LAN PC Card

The 5GHz Wireless LAN PC Card PCWA-C500 is a wireless network card
in a PC card format. You can use the Wireless LAN PC Card to construct a
wireless LAN environment for connecting multiple computers. With the
Wireless LAN PC Card, you can connect to another computer that has a
Wireless LAN PC Card (Peer to Peer Network connection mode), or you
can connect to a network through an optional wireless network access
point, the 5GHz Wireless LAN Access Point PCWA-A500 (Access Point
Network connection mode).

For details on connection modes, see the explanations on the following
pages.

Note

You can register and switch between various network settings, such as between Access
Point Network and Peer to Peer Network connection modes.

With Windows Me or Windows 2000:

Peer to Peer Network connection modeAccess Point Network connection mode
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With Windows XP:

Available networks
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Accessing the Internet from various places in the house
(with Access Point Network connection mode)

Access Point Network connection mode allows you to construct a wireless
network based on an Access Point (optional). By using a computer with a
Wireless LAN PC Card, you can communicate with the Access Point, and
share files with other computers via the Access Point. Furthermore, if you
connect the Access Point to a DSL modem, cable modem or ISDN router,
you can access the Internet from various places in the house.

POWER

MESSAGE

WIRELESS

NETWORK 1

NETWORK 2

Note

The above illustration shows the Access Point connected to an Ethernet LAN, providing
network access to two wireless mobile notebook computers. Refer to the manuals
provided with the Access Point for details.
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High bit rate movie streaming playback*

(with Peer to Peer Nework connection mode)

Peer to Peer Network connection mode allows computers equipped with
Wireless LAN PC Cards to communicate directly, without using a Wireless
LAN Access Point. With this connection mode, users can share files
directly from one computer to another.

Because Peer to Peer Network connection mode is less prone to electronic
interference than Access Point Network connection mode making it
effective over a greater bandwidth, it is recommended that you use Peer to
Peer mode when using high bit rate movie streaming applications.

Note

Poor radio conditions can cause interruptions of movie playback over wireless
connections.

* A system for simultaneously replaying transmitted files on the receiving computer
while file transmission is still in progress.
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System requirements

To use the software provided, the following hardware and software is
required.

❑ A computer with the following specifications:

– 128 MB of RAM (or more)

– A CardBus-compatible PC card slot

– An available CD-ROM drive (for installing the software)

❑ Supported operating system:

– Microsoft® Windows® Millennium Edition

– Microsoft® Windows® 2000 Professional

– Microsoft® Windows® XP Home Edition

– Microsoft® Windows® XP Professional

❑ Display:

High-color (16-bit color) or greater, 800 × 480 resolution or greater

Notes

• Sony cannot assure trouble-free operation for all computers satisfying the
specified system requirements.

• Except for Sony VAIO personal computers upgraded with the regular
Windows XP upgrade service package provided by Sony, Sony cannot
assure trouble-free operation in environments using upgraded operating
systems.

• The 5GHz Wireless LAN Access Point PCWA-A500 (optional) is
required to gain access to the Internet from a wireless LAN.

• Internet access requires the separate purchase of an Internet connection
from an Internet Service Provider (ISP).
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About manuals and Help files
The following manuals and Help file are provided with this product.

❑5GHz Wireless LAN PC Card PCWA-C500 Quick Start Guide
for Microsoft® Windows® Millennium Edition and Microsoft®

Windows® 2000 Professional Users

❑5GHz Wireless LAN PC Card PCWA-C500 Quick Start Guide
for Microsoft® Windows® XP Home Edition and Microsoft®

Windows® XP Professional Users

These two Quick Start Guides contain instructions for installing the
Wireless LAN PC Card, Wireless LAN PC Card driver, and the Wireless
Panel utility software provided. For information regarding most of the
basic settings, refer to the Quick Start Guide appropriate to the version of
Microsoft Windows you are using. Read this guide before using the
Wireless LAN PC Card.

❑5GHz Wireless LAN PC Card PCWA-C500 Operating
Instructions (this manual)

This manual contains instructions for installing the Wireless LAN PC
Card and detailed information about related settings. Refer to this manual
if there is something you cannot find in the Quick Start Guide.

❑Wireless Panel Online Help

This is the Online Help file for the supplied Wireless Panel software.
Refer to this for operating instructions for the Wireless Panel.

Accessing Online Help

To access the Wireless Panel Online Help:

1 Install the Wireless Panel, following the instructions in the
Quick Start Guide.

2 Start the Wireless Panel.

3 Right-click the Wireless Panel icon on the taskbar, and
select Help from the shortcut menu.

z Hint

You can also access Help by clicking the question mark icon on the Wireless Panel title
bar.
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Unpacking

Your Wireless LAN PC Card comes with the following items:

• Wireless LAN PC Card

• PC card case

• CD-ROM (Setup disc)

• Operating Instructions

• Quick Start Guide for Windows Me and Windows 2000 Users

• Quick Start Guide for Windows XP Users

• Warranty Card

• Other printed matter

Supplied software and Wireless LAN PC Card driver

The CD-ROM supplied with this product contains the driver software for
your Wireless LAN PC Card and the Wireless Panel utility software. To
use the Wireless LAN PC Card, you must first install the driver and utility
software.

Refer to the Quick Start Guide for instructions on installing the Wireless
LAN PC Card driver and installing the Wireless Panel utility software.
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Indicators

1 2

1 POWER indicator

2 NETWORK indicator

Indicator modes

POWER NETWORK Description

Blinking rapidly Communication in progress
(The rate of flashing changes with the
amount of data flow.)

Blinking slowly in unison Standby
(Data transfer is possible, however no data
is being sent or received.)

Alternating slow blinking Connection not established
(There is no problem with the Wireless
LAN PC Card, but connection has not been
established.)

OFF Power not supplied
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Insert the card
in the direction
of the arrow.

Inserting the Wireless LAN PC Card
If you are inserting the 5GHz Wireless LAN PC Card
PCWA-C500 for the first time, see Quick Start Guide for
details.

This section explains how to insert and remove the Wireless LAN PC Card
from your computer.

You do not need to turn off your computer when inserting the Wireless
LAN PC Card.

To insert the Wireless LAN PC Card:

1 If your computer has a PC card slot protector, remove it from
the computer.

Some computers offer a PC card slot protector to prevent damage to
the PC card slot while it is not in use.

2 Insert the Wireless LAN PC Card in the PC card slot.

Note

If you have an upper and a lower PC card slot, use the upper slot for the Wireless
LAN PC Card. If you insert the card into the lower slot, the card's antenna may
block the upper slot. See also “Notice for users who have a computer with an upper
and a lower PC card slot” on page 14.

Push the Wireless LAN PC Card into the slot until it is firmly seated.
Inserting the card will extend the eject button.

If the card does not fit easily, do not force it. Remove the card and
reinsert it.
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If your computer is already turned on when you insert the Wireless LAN
PC card, the driver installation wizard starts automatically. Refer to the
Quick Start Guide for details on driver installation.

To remove the Wireless LAN PC Card:

1 Close any software that is using the Wireless LAN.

2 Stop PC Card Services on the taskbar or in Control Panel.

3 Remove the Wireless LAN PC Card, following the
instructions in your computer’s manual for removing PC
cards.

Notice for users who have a computer with an upper and a
lower PC card slot

Notes

• If your computer has an upper and a lower PC card slot, use the upper slot for the
Wireless LAN PC Card. If you insert the card into the lower slot, the card's antenna
may block the upper slot.

• If you insert the Wireless LAN PC Card into a slot other than the one you usually use,
the computer treats the card as a new device and automatically begins installing device
drivers for it. Completing the driver installation makes it possible to use the Wireless
LAN PC Card in that slot. Refer to the Quick Start Guide for details on how to install
the Wireless LAN PC Card driver. (See page 23 for instructions on how to uninstall the
Wireless LAN PC Card.)

z Hint

If you are using Windows Me or Windows 2000, you can register up to eight networks for
each PC card slot. However, you have to register each network individually. You cannot
share the settings.
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About the software provided
The CD-ROM provided contains the following software:

❑5GHz Wireless LAN PC Card driver

This software is required for 5GHz Wireless LAN PC Card PCWA-C500
operation.

❑Wireless Panel

Wireless Panel is a utility software that displays the status of wireless
communications. Normally, it displays the status in the status area on the
taskbar. When using an operating system other than Windows XP,
Wireless Panel is also used to set up computers or switch between
connection settings.

To use the Wireless LAN PC Card, you must first install the Wireless
LAN PC Card driver software and the Wireless Panel utility software.

Refer to the Quick Start Guide for instructions on how to install
the Wireless LAN PC Card driver and the Wireless Panel utility
software.

Notes

• To install the Wireless LAN PC Card software on computers running Windows 2000 or
Windows XP, log on to Windows 2000 as one of the Administrators or to Windows XP
using an account with computer administrator privileges. You cannot install the
software or modify its settings when logged on with any other account.

• To configure the Wireless Panel settings on computers running Windows 2000, log on
to Windows 2000 as one of the Administrators. All other users will be refused the
rights to change settings.

Verifying driver installation

To verify that the Wireless LAN PC Card driver has been installed, perform
the following steps.

Windows Me:

1 From the Start menu, point to Settings, then select Control
Panel.

The Control Panel appears.
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2 Double-click System.

The System Properties dialog box appears.

z Hint

If System is not displayed, click “view all Control Panel options.”

3 Click the Device Manager tab.

4 From the View menu, select Devices by type.

5 Double-click Network adapters.

6 Double-click Sony 802.11a Wireless LAN Adapter.

The Sony 802.11a Wireless LAN Adapter Properties dialog box
appears.

Note

The Wireless LAN PC Card is not working properly if the following occurs:

• The Sony 802.11a Wireless LAN Adapter is represented in the Device Manager
list by a yellow question mark or exclamation point.

c Click Sony 802.11a Wireless LAN Adapter, and click Remove to uninstall the
Wireless LAN PC Card driver. Then, reinstall the Wireless LAN PC Card
driver.
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• Double-clicking Network adapters does not display the Sony 802.11a Wireless

LAN Adapter.

c Remove the Wireless LAN PC Card from the computer, and reinsert it. Then,
reinstall the Wireless LAN PC Card driver.

• Double-clicking Other devices displays the Sony 802.11a Wireless LAN Adapter.

c Click Sony 802.11a Wireless LAN Adapter, and click Remove to uninstall the
Wireless LAN PC Card driver. Then, reinstall the Wireless LAN PC Card
driver.

7 Confirm that the message “This device is working properly”
is displayed under Device status.

Note

If the message “This device is working properly” is not displayed, the Wireless LAN
PC Card is not working properly. In this case, repeat steps 1 to 5, and click Sony
802.11a Wireless LAN Adapter. Then click Remove to uninstall the Wireless LAN
PC Card driver. Next, restart the computer, and reinstall the Wireless LAN PC Card
driver.

8 Click OK.

You are returned to the System Properties dialog box.

9 Click OK to close the System Properties dialog box.

You are returned to the Control Panel.

10 Click  to close the Control Panel.

The Control Panel closes.

When using a computer with an Ethernet interface other than a Wireless
LAN PC Card, it is recommended that you disable the Ethernet interface to
avoid any unexpected difficulties. After completing all of the above steps,
perform the following steps:

1 From the Start menu, point to Settings, then select Control
Panel.

The Control Panel appears.

2 Double-click System

z Hint

If the System icon is not displayed, click “view all Control Panel options”.
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3 Click the Device Manager tab, then double-click Network
adapters.

4 Double-click the network card you want to disable.

5 Click the General tab, then select the Disable in this
hardware profile check box.

Windows 2000:

1 From the Start menu, point to Settings, then select Control
Panel.

The Control Panel appears.

2 Double-click System.

The System Properties dialog box appears.

3 Click the Hardware tab, then click Device Manager.

The Device Manager window appears.

4 From the View menu, select Devices by type.

5 Double-click Network adapters.
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6 Double-click Sony 802.11a Wireless LAN Adapter.

The Sony 802.11a Wireless LAN Adapter Properties dialog box
appears.

Note

The Wireless LAN PC Card is not working properly if the following occurs:

• The Sony 802.11a Wireless LAN Adapter is represented in the Device Manager
list by a yellow question mark or exclamation point.

c Right-click Sony 802.11a Wireless LAN Adapter, and click Remove to
uninstall the Wireless LAN PC Card driver. Then, reinstall the Wireless LAN
PC Card driver.

• Double-clicking Network adapters does not display the Sony 802.11a Wireless
LAN Adapter.

c Remove the Wireless LAN PC Card from the computer, and reinsert it. Then,
reinstall the Wireless LAN PC Card driver.

• Double-clicking Other devices displays the Sony 802.11a Wireless LAN Adapter.

c Right-click Sony 802.11a Wireless LAN Adapter, and click Remove to delete
the Wireless LAN PC Card driver. Then, reinstall the Wireless LAN PC Card
driver.
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7 Confirm that the message “This device is working properly”
is displayed under Device status.

Note

If the message “This device is working properly” is not displayed, the Wireless LAN
PC Card is not working properly. In this case, repeat steps 1 to 5, and right-click
Sony 802.11a Wireless LAN Adapter. Then click Remove to delete the Wireless
LAN PC Card driver. Next, restart the computer, and reinstall the Wireless LAN PC
Card driver.

8 Click OK.

You are returned to the Device Manager window.

9 Click  to close the Device Manager window.

You are returned to the System Properties dialog box.

10 Click OK to close the System Properties dialog box.

You are returned to the Control Panel.

11 Click  to colose the Control Panel.

The Control Panel closes.

When using a computer with an Ethernet interface other than a Wireless
LAN PC Card, it is recommended that you disable the Ethernet interface to
avoid any unexpected difficulties. After completing all of the above steps,
perform the following steps.

1 From the Start menu, point to Settings, then select Network
and Dial-up Connections.

The Network and Dial-up Connections window appears.

2 Click to select the network card you want to disable.

3 From the File menu, select Disable.
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Windows XP:

1 From the start menu, select Control Panel.

The Control Panel appears.

2 Double-click System.

The System Properties dialog box appears.

z Hint

If the System icon is not displayed, click “Switch to Classic View”.

3 Click the Hardware tab, then click Device Manager.

The Device Manager window appears.

4 From the View menu, select Devices by type.

5 Double-click Network adapters.

6 Double-click Sony 802.11a Wireless LAN Adapter.

The Sony 802.11a Wireless LAN Adapter Properties dialog box
appears.
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Note

The Wireless LAN PC Card is not working properly if the following occurs:

• The Sony 802.11a Wireless LAN Adapter is represented in the Device Manager
list by a yellow question mark or exclamation point.

c Right-click Sony 802.11a Wireless LAN Adapter, and click Uninstall to delete
the Wireless LAN PC Card driver. Then, reinstall the Wireless LAN PC Card
driver.

• Double-clicking Network adapters does not display the Sony 802.11a Wireless
LAN Adapter.

c Remove the Wireless LAN PC Card from the computer, and reinsert it. Then,
reinstall the Wireless LAN PC Card driver.

• Double-clicking Other devices displays the Sony 802.11a Wireless LAN Adapter.

c Right-click Sony 802.11a Wireless LAN Adapter, and click Uninstall to delete
the Wireless LAN PC Card driver. Then, reinstall the Wireless LAN PC Card
driver.

7 Confirm that the message “This device is working properly”
is displayed under Device status.

Note

If the message “This device is working properly” is not displayed, the Wireless LAN
PC Card is not working properly. In this case, repeat steps 1 to 5, and right-click
Sony 802.11a Wireless LAN Adapter. Then click Uninstall to delete the Wireless
LAN PC Card driver. Next, restart the computer, and reinstall the Wireless LAN PC
Card driver.

8 Click OK.

You are returned to the Device Manager window.

9 Click  to close the Device Manager window.

You are returned to the System Properties dialog box.

10 Click OK to close the System Properties dialog box.

You are returned to the Control Panel.

11 Click  to close the Control Panel.

The Control Panel closes.
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When using a computer that has an Ethernet interface other than a Wireless
LAN PC Card, it is recommended that you disable the Ethernet interface to
avoid any unexpected difficulties. After completing all of the above steps,
perform the following steps.

1 From the start menu, point to Connect To, then select Show
all connections.

The Network Connections window appears.

2 From LAN or High-Speed Internet, click to select the network
card you want to disable.

3 From the File menu, select Disable.

Uninstalling the Wireless LAN PC Card driver

To uninstall the Wireless LAN PC Card driver, perform the following
steps.

z Hint

Refer to the Quick Start Guide for instructions on how to install the Wireless LAN PC
Card driver.

Windows Me:

Note

Close all programs before uninstalling the dirvier.

1 From the Start menu, point to Settings, then select Control
Panel.

The Control Panel appears.

2 Double-click System.

The System Properties dialog box appears.

z Hint

If System is not displayed, click “view all Control Panel options”.

3 Click the Device Manager tab.
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4 From the View menu, select Devices by type.

5 Double-click Network adapters, then click Sony 802.11a
Wireless LAN Adapter, and click Remove.

The Confirm Device Removal dialog box appears.

6 Click OK.

The message “To finish removing your hardware, you must restart
your computer. Do you want to restart your computer now?” appears.

7 Remove the Wireless LAN PC Card from its slot, and click
Yes.

The system restarts. This completes removal of the driver.

Windows 2000:

Notes

• Log on to Windows 2000 as one of the Administrators.

• Close all programs before uninstalling the dirvier.

1 From the Start menu, point to Settings, then select Control
Panel.

The Control Panel appears.

2 Double-click System.

The System Properties dialog box appears.

3 Click the Hardware tab, then click Device Manager.

The Device Manager window appears.

4 From the View menu, select Devices by type.

5 Double-click Network adapters, then double-click Sony
802.11a Wireless LAN Adapter.

The Sony 802.11a Wireless LAN Adapter Properties dialog box
appears.
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6 Click the Driver tab, then click Uninstall.

The Confirm Device Removal dialog box appears.

7 Click OK.

You are returned to the Device Manager window.

8 Click  to close the Device Manager window.

You are returned to the System Properties dialog box.

9 Click OK to close the System Properties dialog box.

You are returned to the Control Panel.

10 Click  to close the Control Panel.

The Control Panel closes.

Windows XP:

Notes

• Log on to Windows XP using an account with computer administrator privileges.

• Close all programs before uninstalling the dirvier.

1 From the start menu, select Control Panel.

The Control Panel appears.

2 Double-click System.

The System Properties dialog box appears.

z Hint

If the System icon is not displayed, select “Switch to Classic View”.

3 Click the Hardware tab, then click Device Manager.

The Device Manager window appears.

4 From the View menu, select Devices by type.
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5 Double-click Network adapters, then double-click Sony
802.11a Wireless LAN Adapter.

The Sony 802.11a Wireless LAN Adapter Properties dialog box
appears.

6 Click the Driver tab, then click Uninstall.

The Confirm Device Removal dialog box appears.

7 Click OK.

You are returned to the Device Manager window.

8 Click  to close the Device Manager window.

You are returned to the System Properties dialog box.

9 Click OK to close the System Properties dialog box.

You are returned to the Control Panel.

10 Click  to close the Control Panel.

The Control Panel closes.

Removing the Wireless Panel

To remove the Wireless Panel, perform the following steps.

z Hint

Refer to the Quick Start Guide for instructions on how to install the Wireless Panel.

Windows Me:
Note

Close all programs before removing the Wireless Panel.

1 From the Start menu, point to Settings, then select Control
Panel.

The Control Panel appears.

2 Double-click Add/Remove Programs.

The Add/Remove Programs Properties dialog box appears.
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3 Click 5GHz Wireless LAN, then click Add/Remove.

The Confirm File Deletion dialog box appears.

4 Click OK.

The program is removed, and the Maintenance Complete dialog box
appears.

Note

If the ReadOnly File Detected dialog box appears, click Yes to delete the file.

5 Click Finish.

Note

If the Shared File Detected dialog box appears, it is recommended that you click No
and keep shared files.

Windows 2000:

Notes

• Log on to Windows 2000 as one of the Administrators.

• Close all programs before removing the Wireless Panel.

1 From the Start menu, point to Settings, then select Control
Panel.

The Control Panel appears.

2 Double-click Add/Remove Programs.

Add/Remove Programs appears.

3 Click 5GHz Wireless LAN, then click Change/Remove.

The Confirm File Deletion dialog box appears.

4 Click OK.

The program is removed, and the Maintenance Complete dialog box
appears.

Note

If the ReadOnly File Detected dialog box appears, click Yes to delete the file.
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5 Click Finish.

Note

If the Shared File Detected dialog box appears, it is recommended that you click No
and keep shared files.

Windows XP:

Notes

• Log on to Windows XP using an account with computer administrator privileges.

• Close all programs before removing the Wireless Panel.

1 From the start menu, select Control Panel.

The Control Panel appears.

2 Click Add or Remove Programs. (If the Control Panel is set
to Classic View, double-click Add or Remove Programs.)

Add or Remove Programs appears.

3 Click 5GHz Wireless LAN, then click Change/Remove.

The Confirm File Deletion dialog box appears.

4 Click OK.

The program is removed, and the InstallShield Wizard dialog box
appears.

Note

If the ReadOnly File Detected dialog box appears, click Yes to delete the file.

5 Click Finish.

Note

If the Shared File Detected dialog box appears, it is recommended that you click No
and keep shared files.
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Initial settings for constructing a
wireless LAN

Windows Me or Windows 2000

When you install the Wireless Panel onto your computer for the first time,
the Wireless Connection Easy Setup Wizard starts automatically after you
have installed the Wireless Panel. This wizard makes it easy to set up an
initial wireless LAN configuration.

z Hints

• To close the wizard, click Cancel.

• You can later use the Wireless Panel utility to change the connection mode that you
select with the wizard.

• To start the wizard at any time other than immediately after installation of the Wireless
Panel, double-click “InitSetup.exe” in the folder where you installed the Wireless
Panel. (The default location is “C:\Program Files\Sony\5GHz Wireless LAN”.)

Setting up the 5GHz Wireless LAN PC Card PCWA-C500
in Access Point Network connection mode

z Hint

If you want to use the Wireless LAN PC Card in Peer to Peer Network connection mode,
see “Setting up the Wireless LAN PC Card in Peer to Peer Network connection mode”
(page 35).
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1 Select the Use Easy Setup Wizard check box, and click
Next.

The Connection mode panel appears.

2 Select Access Point Network, and click Next.

The Network Setup panel appears.

3 Configure Nickname, Network, and WEP.

Items to be configured:

• Nickname
This is the nickname for the network. You can enter up to 20 ASCII
characters (alphanumeric characters, and may include symbols) for
the Nickname.
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• Network Name
The Network Name is an ID used to identify wireless networks, and
is also referred to as the “SSID”. When connecting to a 5GHz
Wireless LAN Access Point PCWA-A500 that is set to the factory
default settings, enter the factory default Network Name for Access
Point that is printed on the ID label at the rear of the device. When
connecting to a Peer to Peer network, enter the same name for all
computers connected to that network. You can enter up to 32 ASCII
characters (alphanumeric characters, and may include symbols) for
the Network Name. Further, you can change the Network Name.
When you connect to an existing Access Point or Peer to Peer
network, consult your network administrator for information about
the Network Name.

z Hint

To search for other networks operating within the communication range of your
computer, click the Network Name drop-down list. The networks found are
displayed in this list, and you can select the one you want to connect to.

• WEP
WEP is an encryption function that prevents unauthorized access to
wireless networks. When Access Point is shipped, the WEP function
is disabled. When connecting to an Access Point that is set to the
factory default settings, you will need to clear the check mark from
this checkbox. (By default, this check box is not selected.) For
security reasons, it is strongly recommend that you select “Change
access point settings” in step 6 on page 33 to enable the WEP
function of the Access Point. It is also recommend that you select the
checkbox that enables the WEP function when connecting to a Peer
to Peer network. When you connect to an existing Access Point or
Peer to Peer network, consult your network administrator for
information about WEP settings.

• WEP Settings
Set the following items when connecting to a network where WEP is
enabled. When connecting to an Access Point, make sure the settings
match those for the Access Point. When you connect to a Peer to Peer
network, enter the same settings for all computers connected to that
network.

z Hint

When roaming between multiple access points, set the same Network Name and
same WEP Settings for all of the access points being used.



32

[ASCII/Hex]
This is the format for entering the password (WEP key) required
when connecting to networks where WEP is enabled. You can select
ASCII (alphanumeric characters, and may include symbols) or Hex
(hexadecimal notation).

[Length]
This is the length (bit length) for the WEP key (password) required
when connecting to networks where WEP is enabled. You can select
from 40 bits or 104 bits. Generally, the longer the bit length, the
better the security.

[Key]
This is the password required when connecting to networks where
WEP is enabled. The number of characters you can enter differs
depending on the ASCII/Hex and Length settings. (For more
information, refer to following table).

ASCII/Hex 40 bits 104 bits

ASCII 5 characters 13 characters

Hex 10 characters 26 characters

4 When all of the items are set, click Next.

The settings that you have made are displayed.
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5 Confirm your settings, then click Next.

The Connected with access point panel appears when communication
with the Access Point is established. (It may take some time before a
connection is established.)

Note

If an error message is displayed, the settings are not correct. Read the error message
carefully, and click Back to correct the settings.

6 When the Access Point settings are complete:
1 Uncheck the Change access point settings check box, and click Next.
2 Click Finish when the Completing the Wireless Connection Easy

Setup Wizard panel appears.

This completes all the necessary basic configuration for connecting to
a wireless network access point. When you want to change the Access
Point settings, follow the instructions below.

If you change the Access Point settings:

Note

To use an Access Point to connect to the Internet, you must change the Access Point
factory default settings.

1 Check the Change access point settings check box, and click Next.
2 Click Access Point Setup on the panel that is displayed.

Your web browser starts and displays the Access Point setup page.
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Notes

• If your web browser is configured to use a web proxy server, set the web browser
proxy setting so that the browser does not use a proxy server for the Access Point
IP address. (The factory default Access Point IP address is 192.168.11.1.)

• Depending on the firmware version of the Access Point, the Access Point setup
page may differ from the following screen.

7 Set up the Access Point following the onscreen instructions.

z Hints

• For details on how to set up the Access Point, see the manuals provided with
5GHz Wireless LAN Access Point PCWA-A500.

• To use the online help, click the question mark icon on the page.

WARNING

If you change the Network Name (SSID) or WEP settings for the Access Point,
communication between the Access Point and the computer will be lost because the
Access Point and computer settings do not match. If this occurs, change the
computer settings to match those you set for the Access Point.

8 When you have made all of your desired settings changes
for the Access Point, close the Access Point setup page
browser window, return to the Wireless Connection Easy
Setup Wizard, then click Next.
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9 Change the computer settings to match those you set for the
Access Point.

10 Click Next.

The settings that you selected are displayed.

11 Confirm your settings, then click Next.

Communication with the Access Point is established.

z Hint

Refer to the Windows Help or your Windows documentation for information on
sharing files and printers over networks.

12 Click Next.

The Completing the Wireless Connection Easy Setup Wizard panel
appears.

13 Click Finish.

This completes all of the necessary settings.

Setting up the Wireless LAN PC Card in Peer to Peer
Network connection mode

1 When the Wireless Connection Easy Setup Wizard starts,
select Peer to Peer Network on the Connection mode panel,
and click Next.

2 Confirm Nickname, Network Name, and WEP.

z Hint

See pages 30 to 32 for details on settings these items.
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3 When all of the items are set, click Next.

The settings that you have made are displayed.

4 Confirm your settings, then click Next.

Your settings are saved. This may take several minutes.

5 When the Completing the Wireless Connection Easy Setup
Wizard panel appears, click Finish.

6 Configure each computer to be included on this peer to peer
wireless network with the settings you entered above.

This completes all of the necessary settings.

Note

Refer to the Windows Help or your Windows documentation for information on
sharing files over networks.
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Windows XP

Note

Before configuring the Wireless LAN PC Card

Perform the following steps to confirm that the Use Windows to configure my wireless
network settings check box is selected. This option is selected as the default setting.

1 From the Start menu, select Control Panel, then double-click Network
Connections.

2 Right-click Wireless Network Connection, and click Properties.

3 Click the Wireless Network tab.

4 Confirm that the Use Windows to configure my wireless network settings
check box is selected. If it is not selected, select the checkbox.

Setting up the Wireless LAN PC Card in Access Point
Network connection mode

1 After installing Wireless Panel, double-click the Wireless
Panel icon (Received Signal Level indicator) on the task bar.

The Wireless Panel main screen appears.

z Hint

For details on the Received Signal Level indicator, see “Viewing communication
status” on page 45.

2 Click the Network List button on the Wireless Panel.

The Network Connections window appears.

3 When the computer is connected to a wireless network:
Right-click “Wireless Connection *” (where the asterisk represents a
number. This number varies according to conditions) and select
Available Networks from the shortcut menu to display the Connect to
Wireless Network dialog box.

When the computer is not connected to a wireless network:
(In this case, “Wireless Network connection *” in the Network
Connections window is indicated with an “X”.)

Double-click “Wireless Connection *” (where the asterisk represents a
number. This number varies according to conditions) to display the
Connect to Wireless Network dialog box.
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Note

Refer to the Wireless Panel Online Help on how to register additional networks.

4 From Available Networks list in Connect to Wireless
Network, click the network that you want to connect to.

z Hint

Network Names of Access Points within communication range are listed in
Available Networks. The factory default Network Name of the Access Point is
printed on the ID label at the rear of the Access Point, but the Access Point can be
configured to use a different Network Name. When you connect to an existing
Access Point, consult your network administrator for information about the Network
Name.

5 If the WEP function is enabled for the Access Point, enter
the WEP key in the Network key field.

z Hint

WEP is an encryption function that prevents unauthorized access to wireless
networks, and the WEP key is a password required to decode encrypted
transmissions. When Access Point is shipped, the WEP function is disabled. When
connecting to an Access Point that is set to the factory default settings, you will need
to clear this checkbox. (By default, this check box is not selected.) For security
reasons, it is strongly recommend that you refer to enable the WEP function of the
Access Point. For details on how to configure an Access Point settings, refer to the
manuals provided with Access Point. When connecting to an existing Access Point,
consult your network administrator for details on WEP and WEP key settings.
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6 Click Connect.

Communication with the Access Point is established.

If you are not going to change the Access Point settings, this completes
all the necessary settings. If you want to change the Access Point
settings, follow the instructions below.

Note

To use Access Point to connect to the Internet, you must change the Access Point
factory default settings.

7 Click AP Setting on the Wireless Panel.

Your web browser starts and displays the Access Point setup page.

Notes

• If your web browser is configured to use a web proxy server, set the web browser
proxy setting so that the browser does not use a proxy server for the Access Point
IP address. (The factory default Access Point IP address is 192.168.11.1.)

• Depending on the firmware version of the Access Point, the Access Point setup
page may differ from the following screen.
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8 Set up the Access Point following the onscreen instructions.

z Hint

To use the online help, click the question mark icon on the page.

WARNING

If you change the Network Name (SSID) or WEP settings for the Access Point,
communication between the Access Point and the computer will be lost because the
Access Point and computer settings do not match. If this occurs, change the
computer settings to match those you set for the Access Point.

9 When you have made all of your desired settings changes
for the Access Point, right-click the Wireless Network
Connections icon on the taskbar, and select View Available
Wireless Networks from the shortcut menu.

The Connect to Wireless Network dialog box appears.

10 If you have enabled the WEP function of the Access Point
on step 8, enter the WEP key in the Network key field.

11 Click Connect.

This completes all of the necessary settings.

Setting up the Wireless LAN PC Card in Peer to Peer
Network connection mode:

1 After installing Wireless Panel, double-click the Wireless
Panel icon (Received Signal Level indicator) on the task bar.

The Wireless Panel main screen appears.

z Hint

For details on the Received Signal Level indicator, see “Viewing communication
status” on page 45.

2 Click the Network List button on the Wireless Panel.

The Network Connections window appears.
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3 When the computer is connected to a wireless network:
Double-click the Received Signal Level indicator on the taskbar to
display the Wireless Panel and click Network List to display the
Network Connections window. Then, right-click “Wireless Connection

* ” (where the asterisk represents a number. This number varies
according to conditions) and select Available Networks from the
shortcut menu.

When the computer is not connected to a wireless network:
(In this case, “Wireless Network connection *” in the Network
Connections window is indicated with an “X”.)

Double-click the Received Signal Level indicator on the taskbar to
display the Wireless Panel and click Network List to display the
Network Connections window. Then double-click “Wireless
Connection * ” (where the asterisk represents a number. This number
varies according to conditions.)

Note

Refer to the Wireless Panel Online Help on how to register additional networks.

4 Click Advanced.

The Wireless Network Connection Properties dialog box appears.
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5 Click the Wireless Networks tab.
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6 Click Add.

The Wireless Network Properties dialog box appears.

7 Enter a Network name (SSID) for this network (up to 32
characters, and may include symbols).

The Network name is an ID used to identify wireless networks, and is
also referred to as the “SSID”. When connecting to a Peer to Peer
network, enter the same name for all computers connected to that
network. You can enter up to 32 ASCII characters (alphanumeric
characters, and may include symbols) for the Network name. When
connecting to an existing network, consult your network administrator
for information about the Network name.
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8 Select the Data Encryption (WEP enabled( check box, and
clear the The key is provided for me automatically check
box.

Note

WEP is a function designed to prevent unauthorized access to your network data.
When the Data Encryption (WEP enabled) check box is not selected, data is not
encrypted. While you can set up a wireless network without encryption, selecting
this checkbox makes your network more secure.

9 Enter the password (WEP key) in the Network key field.

Note

If you are setting up a new peer to peer network, you can enter any text you want as
the Network key. If you are connecting to an existing peer to peer network, you must
contact the network’s administrator to get the proper key.

The number of characters entered in the Network key field differs according to the
Key format and Key length settings. (See the table below.)

ASCII/Hex 40 bits 104 bits

ASCII 5 characters 13 characters

Hex 10 digits 26 digits

z Hint

When roaming between multiple access points, set the same Network name (SSID)
and same WEP key for all of the access points being used.

10 Click OK.

You are returned to the Wireless Network Connection Properties
dialog box.

11 Click OK.

The settings are saved and you can connect to the newly registered
network.

z Hint

For additional information, refer to Windows XP Help and Support. (From the start
menu, click Help and Support, enter “wireless” into the Search field, and click the
green arrow Go button.)

Note

For details on how to share folders, refer to Windows XP Help and Support or your
Windows documentation.
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Viewing communication status

Viewing the signal reception level

You can check the level of the signal you are receiving using the Received
Signal Level indicator on the taskbar.

Communication status indicator icons for the Access
Point:

Excellent

Good

Intermediate

Acceptable

Poor

Out of range

No card
(The wireless LAN PC card is not installed, was not
properly recognized, or has been disabled.)

Peer to Peer
(Communicating in Peer to Peer Network connection
mode.)

Received Signal Level indicator
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Viewing detailed network information

You can use the Wireless Panel utility to view detailed information about
the network your computer is connected to.

Double-click the Received Signal Level indicator on the
taskbar.

The Wireless Panel main screen appears, indicating the status of the
network that your computer is connected to. For details on each item on the
main screen, see page 48.
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Using Wireless Panel
Wireless Panel is software for displaying the status of wireless
communications. Normally, it runs in the background, displaying the status
of your wireless connection as an icon on the taskbar. You can get more
detailed connection information by displaying its main screen. When using
an operating system other than Windows XP, Wireless Panel is also used to
set up computers or switch between connection settings.

Notes

• To use Wireless Panel to configure a computer running Windows 2000, log on as one
of the Administrators. You cannot configure the system when logged on with any other
account.

• With Windows XP, the operating system’s built-in wireless networking software, rather
than Wireless Panel, is used to configure wireless connections. Wireless Panel is useful
under Windows XP, however, to display connection information.
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Displaying the main screen of the Wireless Panel

To display the main screen of the Wireless Panel, double-click
the Received Signal Level indicator on the taskbar.

The main screen of the Wireless Panel appears, displaying the status of the
network that your computer is connected to.

z Hints

• For details on the Received Signal Level indicator, see “Viewing communication
status” on page 45.

• Move the mouse pointer over each item of the Wireless Panel to display a short
description of that item.

There are three tabs on the main screen of the Wireless Panel.

• Status tab (page 49)

• AP Scan tab (page 51)

• Signal Log tab (page 54)
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 Status tab

1 Wireless Status

This area displays the communication status of the Wireless Panel.

Nickname
The Nickname of the network that computer is currently connected
to. (Created by the user.) If the Nickname is longer than 13
characters, the first 12 characters are displayed and remaining
characters are denoted by an ellipsis (...).

Note

Nickname is not displayed when the Wireless Panel is running on Windows XP.

Network Name
Unique ID for Wireless Network. Also called SSID or ESSID. If the
Network Name is longer than 13 characters, the first 12 characters are
displayed and remaining characters are denoted by an ellipsis (...).

WEP
Indicates whether the data is encrypted or not.

1

2

3 4 5
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Rate
Indicates the data transfer rate.

Frequency
Indicates the communication channel and frequency currently being
used.

Connection mode
Indicates the connection mode for the connected network. “AP
Network” is displayed if the network uses Access Point, and “Peer to
Peer” is displayed if the network consists only of computers
connecting directly without an Access Point.

Signal Level
Indicates the signal level as a bar graph.

Frames Sent
Indicates the number of network data frames that have been sent.

Frames Received
Indicates the number of network data frames that have been received.

2 My Computer

IP Address

Indicates the computer’s IP address.

3 Network List button

Add a network name to or remove a network name from the network
list.

4 Renew IP button

On computers configured to acquire their IP addresses from a central
server, release the current IP address and obtain a new one.

Notes

• This function is not be used when the IP address is fixed.

• This button is not displayed when you are using Windows Me.

5 AP Setting button

View the status or change the settings of the Access Point by accessing
the Access Point’s internal configuration web server. When using the
Peer to Peer Network connection mode, which does not use Access
Point, this button cannot be used.

Note

The AP Setup button can only be used when you are using the Sony 5GHz Wireless
LAN Access Point PCWA-A500.
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AP Scan tab

1 Wireless Status

Displays all networks operating within the communication range of
your computer.

Selected
In this column, “>>>” indicates the currently selected Access Point.

Nickname
Nicknames for networks registered in the Wireless Panel. For
networks not registered in Wireless Panel, this column is blank.

Note

Nickname is not displayed when you are using Windows XP.

Network Name
Unique ID for each Wireless Network.

Mode
Indicates the connection mode for the network. “AP Network” is
displayed if the network uses an Access Point, and “Peer to Peer” is
displayed if the network consists only of computers connecting
directly, without an Access Point.

Signal Level
Indicates the signal level as a number.

1

2 3 4
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WEP
Indicates whether the data is encrypted or not.

Ch
Displays the network channel that is currently being used by the
network.

2 Network List button / Network Registration button

Windows Me/2000:
Network List

When none of the networks on the list is selected, this button appears
as Network List. Clicking the Network List button opens the Network
List box, allowing you to add or remove networks from the list.

Network Registration
If one of the networks in the Network List is selected, this button
changes to Network Registration. Clicking the Network Registration
button opens the Network Registration box, allowing you to register a
new network or change the connection method and settings of the
selected network.

  z Hint

You can also display the Wireless Network Registration dialog box by double-
clicking a network from the list.

Windows XP:
When the computer is connected to a wireless network:

Clicking the Network List button displays the Network Connections
window. Then, if you want to add or remove networks, right-click
“Wireless Connection * ” (where the asterisk represents a number.
This number varies according to conditions) and select Available
Networks from the shortcut menu to display the Connect to Wireless
Network dialog box.

When the computer is not connected to a wireless network:
(In this case, “Wireless Network connection * ” in the Network
Connections window is indicated with an “X”.)
Clicking the Network List button displays the Network Connections
window. Then, if you want to add or remove networks, double-click
“Wireless Connection * ” (where the asterisk represents a number.
This number varies according to conditions) to display the Connect to
Wireless Network dialog box.
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3 Scan button

Clicking the Scan button updates the Network List by searching for all
wireless networks that are currently in range.

Note

This button is not displayed when you are using Windows Me.

4 AP Setup button

View the status or change the setting of the Access Point by accessing
the Access Point’s internal configuration web server. When using the
Peer to Peer Network connection mode, which does not use an Access
Point, this button cannot be used.

Note

The AP Setup button can only be used when you are using the Sony 5GHz Wireless
LAN Access Point PCWA-A500.
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Signal Log tab

1 Signal Log

Displays the signal status and signal rate for signals as a graph.

The red line indicates the data reception rate, the green line the
transmission rate, and the blue line the signal level (strength).

2 Wide Plot button / Narrow Plot button

This button toggles between the Wide Plot and the Narrow Plot display
modes.

When in Narrow Plot mode, click the Wide Plot button to increase the
width of the window. When in Wide Plot mode, click the Narrow Plot
button to return the window to its original (narrow) size.

1

2
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Precautions

Safety

Do not drop or cause a mechanical shock
to the 5GHz Wireless LAN PC Card
PCWA-C500, as this may damage the
unit.

Installation

Do not expose the Wireless LAN PC Card
to the following conditions:

• Unstable surfaces

• High humidity or poor ventilation

• Excessive dust

• Direct sunlight or extreme heat

• Closed cars

• Magnetized location (near magnets,
speakers, or televisions)

• Locations exposed to frequent vibration

• Locations where the transmission of
radio waves may be obstructed by metal
plates or concrete walls

Operation

If the Wireless LAN PC Card is moved
directly from a cold location to a warm
locations, or if it is placed in a very damp
environment, moisture may condense on
the parts inside. The Wireless LAN PC
Card may not operate properly if moisture
condensation occurs.

Cleaning

Clean the casing with a soft cloth, lightly
moistened with water or a mild detergent
solution. Do not use any type of abrasive
pad, scouring powder, or solvent such as
alcohol or benzene as it may damage the
finish of the casing.
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Specifications

Protocol support
TCP/IP compliant

Standard
IEEE802.11a/IEEE802.11

Radio frequency
5.15 to 5.35 GHz

Modulation method
OFDM (IEEE802.11a compliant)

General
Power requirements

3.3 V DC (supplied from the computer
through the PC card adapter)

Current
Peak current at transmission: 560 mA
Peak current at reception: 400 mA

Connector
PC Card CardBus

Dimensions
Approx. 4.7 × 0.2 × 2.2 inches
(Approx. 119 × 5 × 54 mm ) (w/h/d)
(Antenna height: 0.5 inches (Approx. 10.4 mm))

Mass
Approx. 1.8 oz (Approx. 50 g)

Operating temperature
41°F to 95°F (5°C to 35°C) (not condensed)

Environment temperature
-4°F to 140°F (-20°C to 60°C) (not
condensed)

Supplied accessories
See “Unpacking” on page 11.

Design and specifications are subject to change
without notice.

Getting help

This section describes how to get help and
support from Sony, as well as
troubleshooting tips for your Wireless
LAN PC Card.

About Sony’s Support Options

Sony provides several support options for
your Wireless LAN PC Card.

❒This Operating Instructions
explains how to use your Wireless LAN
PC Card.

❒Quick Start Guide explains how to
install the Wireless LAN PC Card,
Wireless LAN PC Card driver, and the
Wireless Panel utility software
provided.

❒Wireless Panel Online Help
explains how to use the Wireless Panel
utility software provided.

❒The Sony Wireless LAN PC Card
support Web site
http://www.sony.com/
wirelesslansupport/ provides the
latest information on your Wireless
LAN PC Card.

❒The Sony e-mail support service
answers your questions by electronic
mail. Just send your question in an e-
mail message and a customer service
representative will reply. To send a
question to Sony e-mail support, fill out
the e-mail form at
http://www.sony.com/
wirelesslansupport/
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❒The Sony fax-back service provides
you with answers to commonly asked
questions. You can use this automated
service to request a list of available
topics then select the topics you want to
receive. To contact the Sony fax-back
service, call
1-877-760-7669.

❒The Sony Customer Information
Services Center offers information
about your 5GHz Wireless LAN Access
Point PCWA-A500, Wireless LAN PC
Card, and other Sony products that work
with your computer. To contact the
Sony Customer Information Services
Center, call 1-877-760-7669.
Open 24 hours/day, 7 days/week.

Glossary
Channel number

The frequency used for wireless
communications. Wireless
communications are available only among
client computers and Access Points that
use the same channel.

Client

A computer connected to a LAN (Local
Area Network). Also may be called a
client computer.

DHCP (Dynamic Host
Configuration Protocol)

DHCP lets network administrators
centrally manage and automate
assignment of client computer IP
addresses.

DNS (Domain Name System)

A system that translates host names into
IP addresses.

Networks that use the TCP/IP protocol,
such as the Internet, use a set of numbers
like 192.168.0.1 (IP address) to identify a
computer. However, since the IP address
is hard to memorize, DNS was developed
to allow a name like “www.sony.com” to
identify a computer for convenience. DNS
servers manage these translations from
host names into IP addresses.
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LAN (Local Area Network)

A network which is accessible only to its
members, unlike the Internet which is
open to an unlimited number of people.  A
LAN may be built for different purposes.
For example, you can build an office LAN
that is accessible only to members of the
same department or a home LAN that is
accessible only to family members.

PPPoE (PPP over Ethernet)

PPPoE is a software protocol that uses a
DSL modem to access the Internet.

With PPPoE, the client does not set a
static IP address. Instead, an IP address is
assigned dynamically whenever the client
accesses the Internet.

Protocol

The formal specifications that define the
procedures for computers to follow when
transmitting and receiving data.

TCP/IP (Transmission Control
Protocol/Internet Protocol)

TCP/IP is the network communications
protocol that is used to communicate over
the Internet. TCP is a connection-oriented
protocol for establishing reliable,
sequenced data transfer. TCP ensures that
data reaches its destination.

IP assembles and addresses data packets
for transmission to their network
destinations.

WAN (Wide Area Network)

A network that interconnects remote
LANs through the Internet or telephone
lines.

WEP

IEEE802.11-compliant security system.

Using the WEP key as the password, only
client computers and Access Points that
have the same ID and password may log
onto the same wireless LAN for file
sharing.
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Troubleshooting

Read the Troubleshooting section of this guide before calling Sony
Customer Information Services. If you still cannot resolve your issue after
reading this section, call Sony Customer Information Services.

Symptom Cause/Remedy

My computer does not
detect the Wireless
LAN PC Card.

Other computers on
the wireless LAN are
not displayed.

I cannot access the
Internet.

c The Wireless LAN PC Card may not be properly inserted
into the PC card slot of your computer. Check that the
Wireless LAN PC Card is inserted in the proper direction,
then push it in as far as it will go.

cYou did not enter the password when Windows started.
Enter the user name and the password requested on
Windows startup, then log on to the LAN.

c The Windows-based environment is not properly set up.
Set it up properly.

cNo other computers are logged onto the wireless LAN.

c The Access Point is not connected.  Follow the
instructions in the Access Point Operating Instructions to
connect it properly.

c The Wireless LAN PC Card is not properly inserted into
your computer. See the instructions on page 13 of this
manual to insert it properly.

cCommunication between the Access Point and your
computer are not established. Check the communication
status using the Wireless Panel. For details on how to
check the status, see "Viewing communication status"
(page 45) and "Displaying the main screen of the Wireless
Panel" (page 48).

c The Access Point is not properly configured. Configure
the Access Point with the connection method of your
choice.

c The Access Point and your computer are too far apart.
Reposition your computer within 150 feet (50 m) of the
Access Point, in direct line of sight. When the Wireless
Panel shows the  icon, move your computer closer to
the Access Point.
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Symptom Cause/Remedy

I cannot remember the
WEP Key.

No communication is
available even though
my computer is
located within 150 feet
(50 m) of the Access
Point, in direct line of
sight.

cWhen using an Access Point, reset the Access Point to its
defaults. For further information about how to reset the
Access Point, see the Access Point Operating Instructions.

cWhen using a Wireless LAN PC Card in Peer to Peer
Connection Mode, delete the network settings registered
on each computer connected to the network, then
reconfigure the computer’s wireless network settings.

c The actual communication distance depends on the
installation site and surrounding conditions. Move your
computer closer to the Access Point.









Printed in Japan

❒ The Sony e-mail support service answers your questions
by electronic mail. Just send your question in an e-mail message
and a customer service representative will reply. To send a
question to Sony e-mail support, fill out the e-mail form at
http://www.sony.com/wirelesslansupport/

❒ The Sony fax-back service provides you with answers to
commonly asked questions. You can use this automated service
to request a list of available topics and then select the topics you
want to receive. To contact the Sony fax-back service, call
1-877-760-7669.

❒ The Sony Customer Information Services Center offers
information about your Access Point, Wireless LAN PC Card,
and other Sony products that work with your computer. To
contact the Sony Customer Information Services Center, call
1-877-760-7669.
Open 24 hours/day, 7 days/week.
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